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Material Notes

* Information here ma%_appl to other spreadsheet software tools
(LibreOffice, OpenOiffice, Google Sheets, etc.).

» These other tools are not approved for use with TTU data.

 All sample data here is either fully anonymized and random OR

publicly available.
* Any connection to real TTU data / events is not intentional.
* | do not intend to make any statements with the sample data presented.

* | don’t know your data — so my examples may not be 100% accurate
with your processing.

o | maK touch on concepts in statistics, but this course isn't meant to
you statistics.
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Our Test Data — Scoop! There It Is!

« Scoop! There It Is! is an ice cream truck serving cool treats to
people all over the city.

* We have 1 year of sales data, which includes:
 How much we posted on social media
* Where the truck was located
* What the weather was like (high temperature and if it was raining)
 How many people passed the truck
« How many people made a purchase
* The total sales from the day

* Not every day is tracked, because even ice cream trucks need
a break!

T



— —
BERRSEEEEEEN

—
[\

E
B
15

Our Test Data — Scoop! There It Is!

Date Weekday
1/1/2022 Saturday
1/2/2022 Sunday
1/3/2022 Monday
1/4/2022 Tuesday
1/7/2022 Friday
1/8/2022 Saturday
1/9/2022 Sunday

1/10/2022 Monday
1/11/2022 Tuesday
1/12/2022 Wednesday
1/13/2022 Thursday
1/19/2022 Wednesday
1/20/2022 Thursday
1/21/2022 Friday

Location
Park

Park
Downtown
Campus
Campus
Mall

Park
Campus
Downtown
Downtown
Campus
Campus
Downtown
Campus

Social Media Posts

R O W N N O O NN O

High Temp Rain Foot Traffic Customer Count

52
38
52
68
52
/3
54
54
56
67
69
46
28
47

O O 0O 0O O 0O 0 o000 o0 o =k K.

71
78
96
231
232
483
305
239
68
89
238
246
107
241

31
21
24
41
14
386
59
17
19
53
8
26
3
17

Total Sales
640.50
433.59
211.27
246.55

92.42
5,667.06
1,252.10

90.86

182.68
504.13
59.10
151.57
31.59
112.42

i NN i i e An

Customer Conversion
43.66%
26.92%
25.00%
17.75%

6.03%
79.92%
19.34%

7.11%
27.94%
59.55%

3.36%
10.57%

2.80%

7.05%




About Our Data

Categories: Facts:

Things that describe our data. These The values we care about for our

can help “Group” our data for insights. business needs. These values are often

summarized.

* Date

° Weekday * Foot Traffic

e Location e Customer Count

» Social Media Posts » Total Sales

» High Temp » Customer Conversion (*careful
. when summarizing

* Rain percentages)

* Foot Traffic ﬁ



Pivot Tables and Charts
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Pivot Tables and Charts

* Pivot Tables are an easy way to build reports on your data in
Excel

* Allow you to group your data by category (date, location,
temperature, college, major, residence hall, etc)

 Allows you to summarize the data by some calculation (total
sales, average traffic, count of students, etc.)

Bl sum of Total Ssales Column Labels  ~

me Labels - | Brewery Campus Downtown Mall Park (blank) Grand Total
Bl <1/1/2022

Jan 5 862.48 5 1,169.73 S 1,220.11 S 8,570.52 S 6,708.33 5 18,531.77
7 2 3 34485 $ 94185 $ 1,289.65 S 7,673.75 S 3,656.32 $ 13,906.43
“Mar 5 1,443.68 S 1,727.61 S 3,4389.60 5 17,263.23 S 3,294.58 5 27,224.71
o N 3 1,693.83 $ 1,115.22 $ 3,893.03 § 9,431.57 § 4,271.19 $ 20,404.90
Ma‘,-’ 5 2,065.53 S 2,251.86 S 8971.35 S 2,589.01 5 37,382.39 $ 53,260.14
Jur‘l S 769.21 S 3,577.08 S 8,742.32 S 25,234.73 S 16,289.49 5 54,612.83




What reports may be relevant with our

data?

* Total sales and customers by date and location
* Average sales and customers by day of week and location

* Average sales by temperature

H

21
24
41
14
386

4 A~ B C D E F G
Date Weekday Location Social Media Posts High Temp Rain Foot Traffic Customer Count
1/1/2022 Saturday Park 4 52 1 71
1/2/2022 Sunday Park 5 38 1 78
1/3/2022 Monday Downtown 2 52 0 96
1/4/2022 Tuesday Campus 2 68 0 231
n 1/7/2022 Friday Campus 0 52 0 232
1/8/2022 Saturday Mall 4 73 0 483
n 1/9/2022 Sunday Park 0 54 0 305

59

J

Total Sales Customer Conversion
31 S

S
S
S
S
S
S

640.50
433.59
211.27
246.55
92.42
5,667.06
1,252.10

43.66%
26.92%
25.00%
17.75%

6.03%
79.92%
19.34%



Pivot Table Creation

1. Select all your data (ideally by selecting the column letters)
2. Go to the “Insert” menu and select “PivotTable”

3. Confirm that the “Table/Range” field is the correct value (for
our test data, it should be “SampleData!$A:$J”)

4. State where you want the PivotTable to be created. The
default of “New Worksheet” is fine for our purposes, but you
could also tell Excel to crate the PivotTable in a specific cell.
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. A Al s C PivotTable Fields
PivotTable Parts B

-

* Field List shows all of
your available data
fields.

* Filters will filter your
data by a category.

* Rows and Columns
break data out by
categories.

 Values will hold your
data summaries.

To build a report, choose
fields from the PivotTable
Field List
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About Our Data

« Categories: * Facts:
» Date * Foot Traffic
« Weekday e Customer Count
 Location » Total Sales
» Social Media Posts » Customer Conversion (*careful
» High Temp when summarizing
. Rain percentages)
* Foot Traffic
Use these in “Rows”, Use these in “Values”

“Columns”, and “Filters”

T



Rows and Columns

* Will identify distinct category values in your dataset
* Will separate your data points by the categories
« Will NOT fill in any gaps (days of the week not represented)

ESumnfTutaISales Column Labels -

Row Labels -1 Brewery Campus Downtown Mall Park Grand Total
HSLJr‘u:iEl‘:,-r S 6,146.99 S 90,325.86 5 68,105.35 5164,578.71
Mﬂﬂdﬂ"y' S 5,891.53 511,198.12 S 17,089.65
H Tuesday S 6,716.47 511,539.05 S 18,255.53
EWE[:IHEECIE‘,-’ S 3,444.39 513,527.73 S 16,972.12
Thurﬁda‘g’ S 4,668.35 510,670.88 S 15,339.22
Friday S 5,034.17 512,900.49 S 17,934.66
Saturday S 6,411.13 S 68,586.30 5103,936.05 5178,933.47
Grand Total 5 12,5568.12 $25,754.91 %59,836.27 5158,012.16 5172,041.90 $429,103.36
|

Ti.l_l.i



Values

« Perform some summary (count, average, sum, etc) on a "fact" in your
dataset

« Will NOT fill in any gaps (data intersections not represented in your data)
* Do not summarize on percentage data

3 Ssum of Total Sales Column Labels ~

Row Labels -1 Brewery Campus Downtown Mall Park Grand Total
Sunday S 6,146.99 S 90,325.86 5 68,105.35 5164,578.71
M Monday S 5,891.53 511,198.12 S 17,089.65
Tuesday S 6,716.47 511,539.05 S 18,255.53
A \Wednesday S 3,444.39 513,527.73 S 16,972.12
2B Thursday S 4,668.35 510,670.88 S 15,339.22
Wl Friday S 5,034.17 512,900.49 S 17,934.66
Saturday S 6,411.13 S 68,586.30 5103,936.05 5178,933.47

8 Grand Total 5 12,558.12 525,754.91 559,836.27 5158,912.16 5172,041.90 5$429,103.36




Report 1: Total sales and customers by
time and location

n Column Labels -

Sum of Customer Count Sum of Total Sales Total Sum of Customer Count Total Sum of Total Sales
ﬂm}w Labels | =  Brewery Campus Downtown Mall Park Brewery Campus Downtown Mall Park

Jan 78 209 128 554 302 S 862.48 S 1,169.73 S 1,220.11 S 8,570.52 5 6,708.33 1271 5 18,531.77
HFEb 34 173 123 434 188 5 34485 S 94185 5 1,289.65 5 7,673.75 S 3,656.32 1024 5 13,906.43
El".-"lar 130 38l 367 1023 171 S 1,449.68 S5 1,727.61 5 3,489.60 5 17,263.23 S 3,294.58 2052 5 27,224.71
Apr 149 247 376 652 208 5 1,693.89 $ 1,115.22 § 3,893.03 5 943157 S5 4,271.19 1632 5 20,404.90
10 LEN 135 460 780 193 1308 S 2,065.53 S 2,251.86 S 8,97L.35 5 2,589.01 S5 37,382.39 2876 5 53,260.14
17 By 43 627 717 1296 791 &5 ?69.21| 5 3,577.08 _|$ 8,742.32 § 25,234.73 S 16,289.49 3480 5 54,612.83

Drag fields between areas below:
[ ]

Drag “Date” to rows, which automatically Y e
summarizes by month

Drag Location to columns
Drag Sales and Customers to values
Change Sales to report in dollar values




Report 2: Average sales and customers

by day of week and location

= Brewery
H Sunday
Saturday
ﬂ = Campus
“ Monday
Tuesday
Wednesday
11 Thursday
Friday
= Downtown
Monday
15 Tuesday

37.15384615
36.85714286
37.5
46.14678399
46.30769231
39.76190476
35.71428571
43.4
45.38095235
49.05504587
45.71428571
42.52

R I P ¥ e N e N "N E " ¥ i S WSl o

8 Row Labels leAveragE of Customer Count Average of Total Sales

433.00
439.07
234.26
230.28
226.60
319.83
164.02
233.42
239.72
548.96
233.24
461.56

EI0S DEDWEEN areas Delow.

Y Filters Il Columns
| % Walues

Rows % Values

|Pa.1.rerage of Customer C... ™ |
|

| Average of Total Sales =




Report 3: Average sales by temperature

Row Labels ~ Count of Date Average of Customer Count Average of Total Sales

(blank)
16-25
26-35
36-45
46-55
56-65
M 60-75
76-85

M 36-95
tl 96-106

Grand Total

12
38
30
46
46
75
59
313

4.3333333332
&
33.33333333
46.76315759
40.366606667
0l.63043475
110.2826087
99.74666667
147.5254237
87.94249201

W L L U WL WS W 10 40

28.19
72.27
435.35
644.31
586.91
707.92
1,5338.98
1,501.59
2,788.23
1,270.94

Filters

F':. WS

Il Columns

| % Values

E Values

High Temp

- | |Cnuntnf Date

| Average of Customer C..,

| Average of Total Sales




Charts

« Bar charts show counts or totals grouped by a category

 Pie charts show how distinct categories make up parts of a
whole

* Line charts show changes in value over time

 As with other charts in Excel, you have all of the same tools to
adjust labels, titles, colors, and other chart elements

T



Bar and Pie Chart Examples

Sum of Total Sales

Row Labels @Sum of Total Sales
4 $ 12,558.12 Total

Campus g 25,754.91 »200.000.00

Downtown 5 59,836.27 $150,000.00

Mall 5 158,912.16

Park g 172,041.90 >100,000.00 m Total

Grand Total 5 429,103.36 550,000.00 I

Sum of Total Sales 5 . .
Brewery Campus  Downtown Mall Park
Total Location +¥

Location T

= Brewery

= Campus

= Downtown
Mall

m Park




Stacked Area Chart Example

« Set "Sum of S
Total Sales" to
be a "Running
Total In > Date” ==

5300,000.00

* Notice date
gap: Jan 9 - 20

» Solution: Build 515000000
a list of dates
and use -
GetPivotData o
to fetch values dRES

Location T
m Park

Mall
m Downtown
m Campus

m Brewery




Analysis ToolPak
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To Enable: —

E‘%@ View and manage Microsoft Office Add-ins.

1. Click on "File" in the top left

Data Add-ins

and then "Options" towards
the bOttom- save i:iifﬁglfs:lz:g;i:rgGMAddin Ch..dindll  COM Add-u

Language Analysis ToolPak Cha.32XLL  Excel Add-ir

2. In the "Excel Options" window | s G LA el A
that opens, click on "Add-ins” s e M eetaan
on the left, and then click the N e So et

bUtton that Says "GO " " | Add-ins l!':!?cl-:!:uft,_ﬂxctinTspane3_ e ;P?’ITE‘:S:;:

Trust Center 7 I )
3. Check the box next to Adbon Aot DRk e COM
"AnalySIS TOOIPak" and then Compatibility: Mo compatibility information available

. n 1) Location: C\Program Files (x86)\Adobe\Acrobat DCY
CI ICk O K PDFMaker, Office\ PDFMOfficefddin.dll

4. When enabled, it should be in
the "Data" ribbon menu.

Manage: | Excel Add-ins




Analysis Limitations: Text

 String data is hard to analyze

* Binary strings (yes/no, true/false) can be mapped to 0 and 1

« Categories with some defined order can sometimes be mapped
to integers

* Freshman, Sophomore, Junior, Senior
« Strongly Agree, Agree, Disagree, Strongly Disagree

« Our “Rain” column is a binary yes/no, so it is coded as 1s and
Os

* Weekday and Location can’t be mapped to numbers as easily

T



Correlation

* Helps describe a relationship between variables in your dataset.

A positive correlation means two variables will change in the
same direction (increase/decrease together).

* A negative correlation means two variables will change in
opposite directions (increase in one, decrease in the other).

* Values close to +/-1 show a strong correlation, values close to O
show weak / no correlation

 Correlation is not causation: the relationship does not mean that
one change causes the other.

T



Correlation

1. Click the "Data Analysis" tool in the "Data” menu.
2. Select "Correlation”

3. Select your data for the "Input Range" (entering in column
letters), check the "Labels in First Row" box, and click "OK"

Social Media Posts High Temp Rain Foot Traffic Customer Count Total Sales

Social Media Posts 1.00

High Temp -0.07 1.00

Rain 0.01 -0.10 1.00

Foot Traffic 0.02 0.07 -0.40 1.00

Customer Count 0.25 0.35 -0.25 0.73 1.00

Total Sales 0.24 0.29 -0.17 0.60 0.91 1.00

* Green cells are our high(er) correlated values.

 Blue cells may be moderately correlated. E



Regression

» Attempts to create a function that can predict a given value.

* In our case, given known values for temperature, rain, traffic,
etc — how can we predict our daily sales?

* Values:
* R Square: How well the model fits the given data, ideally above 0.95.

» Coefficient: This value will be multiplied by your variable to produce the
predicted output.

* P-Value: A p-value less than 0.05 means the variable is a likely
predictor of your output.

T



Regression

1. Click the "Data Analysis" tool in the "Data” menu.

2. Select "Regression”

3. Select the value you want to predict as the "Input Y Range”
4.

Select the values that will influence this output as the "Input X
Range”

5. Check the "Labels" box and the "Confidence Interval"” box,
then "OK"

Note: In items 3 and 4, you will need to specifically select the
cells with data (H1:H314), not just the full column (H:H)

T



Regression (R Square: 0.83)

Coefficients P-value Note
Intercept 335.88 0.32 Ilgnore: High P-Value
Social Media Posts -23.07 0.55 lgnore: High P-Value
High Temp -7.08 0.04
Rain 152.38 0.40 lgnore: High P-Value
Foot Traffic -2.55 0.00
Customer Count 23.65 6.09E-75

* Theoretically, we can predict sales with this formula:

dailySales = $-7.08 * highTemp + $152.38 * rain + $-7.08 * footTraffic +
$23.65 * customerCount

* This fails to consider the text category of "Location", which was
a large contributor of sales.

T



Descriptive Statistics

* Allows you to see some various values that describe a given
variable.

o Statistics:
 Mean — average
* Median — "middle"” number when sorted low to high
« Standard Deviation — how much the value can vary
« Skewness — is the distribution of your data shifted to one side

T



Skewness

Skewness =0

!

Skewness > (

Skewness < 0
>
T

Value Frequency

Daily Sales ﬁ



Descriptive Statistics

1. Click the "Data Analysis" tool in the "Data” menu.
2. Select "Descriptive Statistics”

3. Select your data for the "Input Range" (entering in the column
letters)

4. Check the "Labels in First Row" box and the "Summary
Statistics" box, then "OK"

T



Descriptive Statistics

Mean

Standard Error

Median
Mode

Total Sales

Standard Deviation

Sample Variance

Kurtosis
Skewness
Range
Minimum
Maximum

Sum

Count

1370.937
139.6033
399.0955

2469.834
6100081
7.653245
2.805633
12895.57
0
12895.57
429103.4
313

 Average sales is $1371, but median
is $399.

* Lots of small sale days, a few REALLY
large sale days

« Standard Deviation is $2469, so the
daily sale value varies quite a bit.

« Skewness is fairly large




Actual Data Distribution

Countof Date

Total

* Heavily skewed towards
smaller daily sales

* Positive Skewness




Questions? Answers?
Favorite PivotTable Uses?

T
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